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1. Introduction

This User’s Guide describes how to install, use the RATOC PCIFU2U 1394 & USB2.0 Combo

PCI Board(called PCIFU2U in this User’s Guide).

The information in the README.TXT file on the CD-ROM may include the latest information.

Be sure to read the README.TXT file as well.

1-1. Package Confirmation
Confirm the package contents:

• PCIFU2 1394 & USB2.0 Combo PCI Board

• Support CD-ROM

• User’s Guide (This document)

• Software License Agreement

NOTE

If any of these items are missing from the PCIFU2U retail package, contact your

supplier immediately.

1-2. System Requirements
Your PC must meet the following requirements:

<Windows>

•PC with one free PCI 2.1/2.2 compliant slot

•Windows XP/Me/2000/98 SE

•ACPI BIOS

<Mac>

•PowerMac G4/G3/604e with one free PCI slot

•Mac OS 9.1/9.2.x/10.1 or later

<For Video Editing>

•Pentium II 300MHz or faster for video editing

•At least 64 MB memory for video editing

•High performance AGP Graphic Board for video editing

•High performance Sound Board for video editing

•High performance DMA enabled Hard Disk Drive for video editing

•Sufficient Hard Disk space for video capture (1 second DV video =3.6MB)for video editing
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1-3. Restrictions

1.When you export a DV-AVI file at a 1394 Hard Disk Drive to a DVCAM, the video image or

    its sound gets choppy.

2.When you capture a video image as a DV-AVI file into a 1394 Hard Disk Drive directly with

   Canon DM-CV11 or Hitachi VM-D1, the video image sometimes contains noise.

3.Suspend mode may not work with the PCIFU2U(A device connected to the PCIFU2U

    may not be recognized with suspend mode function).

4.You may not use the PCIFU2U on a PC with standard 1394 port because of confliction

    of its preinstalled 1394 applications/drivers.

5. If you use the PCIFU2U with a Mac, Apple support USB drivers(Mac OS standard driver)

     are required. Only Low/Full Speed (1.5/12Mbps) is supported on a Mac.

6. Our original USB2.0 driver doesn’t support High Speed Isochoronous data transfer. We plan

to release a USB2.0 drivers supporting the High Speed Isochoronous

      data transfer at our web site(http://www.ratocsystems.com/english/).

7.We strongly recommend you to use USB2.0 driver available through “Windows Update”

    on Windows XP/2000. You may use our original USB2.0 drivers, but we don’t support

    them when Microsoft officially releases its USB2.0 driver.



3

For Windows Users

Microsoft Standard WDM DV filter drivers captures DV data stream and save as an AVI

file which consists with original DV data stream. This DV data stream requires 3.6MB/

sec and includes 720x480 resolution video data(NTSC). Also, the file size is restricted

up to 4GB (about 19 minutes). As our application named RsDvCap uses this DV file

which is a different file format from AVI file of Windows 3.1/95, you need special Video

Editing Software to open and edit it.

If you want to edit video captured by our RsDvCap application, you have two choices:

1.You have to use Video Editing Software which can treat DV-AVI2 format.

    If you have Adobe Premiere 5.1, you have to update your Premiere to 5.1c.  5.1c

     updater is available at www.adobe.com. Then please install our Premiere Plug-In

     included in this package. With the Premiere Plug-In, your Premiere can treat DV-

     AVI2 format file.

    MediaStudio Pro 6.0, MGI VideoWaveIII can treat DV-AVI2 format.

     If your Video Editing Software can not treat DV-AVI2 format file, you need file

     format conversion both before and after editing as described below.

2.If your Video Editing Software can not treat DV-AVI2 format file, you have to use

   our CompressAVI application to convert DV-AVI2 format to other formats which

   your Video Editing Software can treat.

1-4.Compatibility with Video Editing software
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*1

For Mac OS 9.x users

You can use the following video editing software with the PCIFU2U.

(In November in 2001)

For more information, contact the manufacturer of the software.

D
ata Im

port from
 a D

V
 device

Video Editing

Controlling a D
V

 device

Exporting to a D
V

 device

Manufacturer         Software

Adobe       Premiere 5.1c, 6.0        O.K.     O.K.      O.K.       O.K.

     Apple     Final Cut Pro 1.2, 2.0     O.K.     O.K.      O.K.       O.K.

     Apple         iMovie, iMovie2        O.K.     O.K.      O.K.       O.K.

     DigitalOrigin           EditDV 1.6        O.K.     O.K.      O.K.       O.K.

     DigitalOrigin     EditDV Unplugged 1.6.1         O.K.     O.K.      O.K.      O.K.

     DigitalOrigin         MotoDV 1.1.3       O.K.         -         O.K.          -

     DigitalOrigin           PhotoDV 1.4       O.K.         -         O.K.          -

     STRATA       VIDEO Shop 4.5       O.K.      O.K.      N.G.       N.G.

*1 *1

*1*3

*1*3 *1*3

*1*3

*2

*1 You need to set [QuickTime FireWire DV Support], [QuickTime FireWire DV Enabler]

      inactive with the [Extensions Manager].

*2 The next version(VIDEO Shop 5) will be able to treat these functions.

*3 You need to download EditDV 1.6 update driver from the Digital Origin web site.

       (http://www.digitalorigin.com/)

*2
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2. Hardware Setup

2-1. Setup Procedure

Here’s the setup procedure:

1)Installing the PCIFU2U into a PCI slot(For Windows users or Mac users)

       ==>Refer to Chapter 2-2

2)Installing the drivers(For Windows users)

       ==>Refer to Chapter 3-1 through 3-5

    Confirming the drivers(For Mac users)

       ==>Refer to Chapter 3-6

3)Installing bundled software(For Windows users)

       ==>Refer to Chapter 4, 5
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2-2. PCIFU2U Board

Before installing the PCIFU2U into a PCI slot,understand the usage of the connectors on the

PCIFU2U.

CN1, CN2

 CN3, CN4

CN5

J1

1394 6pin connector

CN1
CN2

CN3
CN4

CN5 J1

USB2.0 connector

 Connector to be used for attaching an optional Front Bay Kit

1394 Cable Power connector

You have to connect this J1 to a HDD power connector of your

computer to use a cable-powered device such as a 1394 portable

HDD,CCD camera,etc.

If you don’t have an optional Front Bay Kit, proceed to Chapter 2-2-1.

If you have an optional Front Bay Kit, proceed to Chapter 2-2-2.
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2-2-1. Installing the PCIFU2U

    Follow the steps to install the PCIFU2U into a PCI slot.

    1.Turn off your PC and open the computer cabinet.

2.Carefully install the PCIFU2U by firmly pressing the PCI board into a PCI expansion slot.

    Please note the following:

                       a)You have to install the PCIU2U firmly. If the PCIU2U isn’t installed firmly, this

          product or your PC may get damaged.

                     b)Be sure the gold contact of the PCI board is completely in a white PCI slot.

3.Fasten the retaining bracket with a screw.

4.If you connect a cable-powered type 1394 device such as a portable HDD,CCD camera

    which requires cable power source, you have to connect a HDD power connector of your

    computer to J1 connector on the PCIFU2U. If you connect a self-powered type 1394 device

    such as a DVCAM, you don’t need to connect the HDD power connector of your computer

    to J1 connector.

5.Close the computer cabinet.

   Then, you have to install the driver for the PCIFU2U.

   ==>Refer to Chapter 3-1 if you use Windows 98SE.

   ==>Refer to Chapter 3-2 if you use Windows Me.

   ==>Refer to Chapter 3-3 or 3-4 if you use Windows 2000.

   ==>Refer to Chapter 3-5 if you use Windows XP.

   ==>Refer to Chapter 3-6 if you use Macintosh.
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2-2-2. Attaching the Front Bay Kit to the PCIFU2U

    If you have an optional Front Bay Kit, follow the steps to attach it to the PCIFU2U.

    If you attach the optional Front Bay Kit to 3.5 inch front bay, refer to Chapter A).

    If you attach the optional Front Bay Kit to 5 inch front bay, refer to Chapter B).

A.Installing to 3.5 inch bay

  1.Turn off your computer. Then, attach the bundled cable to the connector on the Front Bay

     as shown below.

Bundled calbe



9

  2.Slide the front-bay into the 3.5 inch bay as shown below.

  3.Open the computer cabinet and fix the front-bay with the bundled screws.

Fix two points.

Fix two points on the other side.

Use this type of screws.

There are two types of

screws in this package.



10

  4.Attach the other end of the cable to the PCIU2U as shown below.

  5.Install the PCIU2U into a PCI slot and close the computer cabinet.

      Please note the following:

                         a)You have to install the PCIU2U firmly. If the PCIU2U isn’t installed firmly, this product

                       or your PC may get damaged.

                      b)Be sure the gold contact of the PCI board is completely in a white PCI slot.

                     c)Be sure to fasten the bracket of the PCI board with a screw as shown below.

   Then, you have to install the driver for the PCIFU2U.

   ==>Refer to Chapter 3-1 if you use Windows 98SE.

   ==>Refer to Chapter 3-2 if you use Windows Me.

   ==>Refer to Chapter 3-3 or 3-4 if you use Windows 2000.

   ==>Refer to Chapter 3-5 if you use Windows XP.

   ==>Refer to Chapter 3-6 if you use Macintosh.
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B.Installing to 5 inch bay

  1.Turn off your computer. Then, slide rails into the front panel until they are firmly seated as shown below.

Holes

Holes

  2.Fix the front-bay to the holes shown above with the screws to attach the front bay to the rails.

Use this type of

screws.

There are two types of

screws in this package.

  3.Attach the bundled cable to the front bay. Then, attach the clasp as shown below.

Bundled cable



12

  4.Open the computer cabinet and slide the front bay into the front panel as shown below.

  5.Fix the front bay with the screws.

Use this type of

screws.

There are two types of

screws in this package.

  6.Attach the other end of the cable and install the PCIU2U into a PCI slot, following the instructions

     described at step 4 to 5 in Section A in Chapter 2-2-2.

   Then, you have to install the driver for the PCIFU2U.

   ==>Refer to Chapter 3-1 if you use Windows 98SE.

   ==>Refer to Chapter 3-2 if you use Windows Me.

   ==>Refer to Chapter 3-3 or 3-4 if you use Windows 2000.

   ==>Refer to Chapter 3-5 if you use Windows XP.

   ==>Refer to Chapter 3-6 if you use Macintosh.
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This section describes the driver installation.

•When your Windows version is Windows 98 SE(Second Edition), proceed to Chapter 3-1.

•When your Windows version is Windows Me(Millennium Edition), proceed to Chapter 3-2.

•When your Windows version is Windows 2000, proceed to Chapter 3-3 or 3-4.

  If you would like to use our original USB2.0 driver, proceed to Chapter 3-3.

  If you would like to use Microsoft USB2.0 driver, proceed to Chapter 3-4.

•When your Windows version is Windows XP, proceed to Chapter 3-5.

•If you use the PCIFU2U with a Mac, proceed to Chapter 3-6.

3. Driver Installation
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3-1.Windows 98 SE Installation

To use the PCIFU2U on Windows 98 SE, follow the steps through.

1.When you start your PC after installing the PCIFU2U, the following wizard will appear.

    Insert the bundled RATOC USB2.0 CD-ROM into the CD-ROM drive and click [Next].

2.Select the [Search for the best driver for your device(Recommended)] option and

    click [Next].

3.Uncheck the all options and click [Next].
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4.Click [Next].

5.Click [Finish].

6.When you see the following message, click [No].
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7.The following wizard will appear. Click [Next].

8.Select the [Search for the best driver for your device(Recommended)] option and

    click [Next].

9.Uncheck the all options and click [Next].
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10.Select the [The updated driver(Recommended)] option and click [Next].

11.Click [Next].

12.Click [Finish].
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13.The following wizard will appear. Click [Next].

14.Select the [Search for the best driver for your device(Recommended)] option and

     click [Next].

15.Uncheck the all options and click [Next].



W
indow

s 98SE

19

16.Select the [The updated driver(Recommended)] option and click [Next].

17.Click [Next].

18.Click [Finish].

19.The same hardware wizards shown at step 13 through 18 will appear again.

      Follow the same procedure as described abobe.
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20.The following wizard will appear. Click [Next].

21.Select the [Search for the best driver for your device(Recommended)] option and

     click [Next].

22.Select the [Specify a location] option and type [E:\PCIU2] and click [Next].

      (E means your CD-ROM drive letter. If your CD-ROM is “F”, you have to type [F:\PCIU2].)
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23.Make sure Windows found the PCIEHCI.INF file at the PCIU2 folder in the CD-ROM

      drive. Then, click [Next].

24.Click [Finish].

25.If you would like to use a DVCAM, you need to install the MSDV patch program as

described below. Follow the steps through to install it.

      1)Insert the bundled RATOC IEEE1394 CD-ROM into your CD-ROM drive.

      2)Open [My Computer] and double-click the CD-ROM drive icon.

      3)Double-click the [Win98se] folder and double-click the [DvPatch] folder.

      4)Double-click [252640USA8.EXE] to install the MSDV patch program.
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26.You should update your Windows 98 SE to improve performance. To update your Windows

       98 SE, follow the steps through.

     1)Click the Start button.

     2)Select Windows Update.

     3)You will see the screen below. Click PRODUCT UPDATES.

27.You will see the screen below.Check Storage Supplement Update and download the

component. After installing, please restart your PC. For more information on the component,

      refer to Read this first on the screen.

28.Restart your PC.
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29.To confirm the installation, follow the steps through:

       Right-click on [My Computer], select [Properties], and the [Device Manager] tab.

       Please confirm the following three strings:

1)Confirm there is a [Texas Instruments

   OHCI Compliant IEEE 1394 Host

   Controller] string under the [1394 Bus

   Controller].

2)Confirm there is a [PCI standard PCI to

    PCI bridge] string under the [System

   devices].

3)Confirm there are two [NEC USB Open

    Host Controller] strings and a

   [RATOC PCI USB Enhanced Host

    Controller] under the [Universal Serial

    Bus controllers].

30.Refer to Chapter 4 and 5 to install our original software/utility.
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3-2.Windows Me Installation

To use the PCIFU2U on Windows Me, follow the steps through.

1.When you start your PC after installing the PCIFU2U, the following wizard will appear.

    Insert the bundled RATOC USB2.0 CD-ROM into the CD-ROM drive and

    select the [Automatic search for a better driver(Recommended)] option. Then, click

   [Next].

2.Click [Finish].

3.Select the [Automatic search for a better driver(Recommended)] and click [Next].
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4.Select [RATOC PCI USB Enhaced Host Controller] and click [OK].

5.Click [Finish].

6.Select the [Automatic search for a better driver(Recommended)] option and click [Next].
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7.Click [Finish].

8.When you see the following message, click [Yes].
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9.To confirm the installation, follow the steps through:

    Right-click on [My Computer], select [Properties], and the [Device Manager ] tab.

    Please confirm the following three strings:

1)Confirm there is a [Texas Instruments

    OHCI Compliant IEEE 1394 Host

    Controller] string under the [1394 Bus

    Controller].

2)Confirm there is a [PCI standard PCI to

    PCI bridge] string under the [System

   devices].

3)Confirm there are two [NEC USB Open

    Host Controller] strings and a

   [RATOC PCI USB Enhanced Host

    Controller] under the [Universal Serial

    Bus controllers].

10.Refer to Chapter 4 and 5 to install our original software/utility.
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After confirming Service Pack 2 or later is installed, follow the steps through:

1.When you start your PC after installing the PCIFU2U, the following wizard will appear.

    Insert the bundled RATOC USB2.0 CD-ROM into the CD-ROM drive and click [Next].

Before you install the driver, make sure Windows 2000 Service Pack 2 or later is already installed. To

confirm Service Pack 2 or later is installed, right-click on [My Computer], and then select [System

Properties].If you can find a “Service Pack 2” string as shown below, Service Pack 2 is already

installed in your system.

NOTE:If you have installed Microsoft USB2.0 in Chapter 3-4, you don’t need to install our

              original USB2.0 driver.

You can install our original USB2.0 driver. But, please note that when Microsoft officially releases its

USB2.0 driver for Windows 2000, we will finish supporting our USB2.0 driver for Windows 2000. If you

install Microsoft USB2.0 driver, refer to 3-4.

3-3.Windows 2000 our USB2.0 Driver Installation
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3.Select the [Specify a location] option and click [Next].

4.The following dialog box will appear. Type [E:\PCIU2] and click [OK].
          (E means your CD-ROM drive letter. If your CD-ROM is “D”, you have to type

          [D:\PCIU2].)

2.Select the [Search for a suitable driver for my device(recommended)] option and click

   [Next].
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6.Click [Finish].

7.When you see the following message, click [Yes].

5.Make sure Windows found the PCIEHCI.INF file at the PCIU2 folder in the CD-ROM

    drive. Then, click [Next].
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8.To confirm the installation, follow the steps through:

    Right-click on [My Computer], select [Properties], and the [Hardware] tab.

    Click the [Device Manager] button. Please confirm the following three strings:

1)Confirm there is a [Texas

     Instruments OHCI Compliant

     IEEE 1394 Host Controller] string

    under the [IEEE 1394 Bus host

    controllers].

2)Confirm there is a [PCI standard PCI

    to PCI bridge] string under the

   [System devices].

3)Confirm there are two [NEC PCI to

    USB Open Host Controller] strings

    and a [RATOC PCI USB

    Enhanced Host Controller] under

    the [Universal Serial Bus

    controllers].
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After confirming Service Pack2 or later is installed, follow the steps through:

1.When you start your PC after installing the PCIFU2U, the following wizard will appear.

   Click [Next].

In November in 2001, Microsoft doesn’t release its USB2.0 driver for Windows 2000.

But, if Microsoft USB2.0 driver for Windows 2000 gets available through “Windows Update”,

you can install the driver, following the steps below. Please note that you have to access to the Internet

to install it. If you can’t access to the Internet, refer to Chapter 3-3.

3-4.Windows 2000 Microsoft USB2.0 Driver Installation

Before you install the driver, make sure Windows 2000 Service Pack 2 or later is already installed. To

confirm Service Pack 2 or later is installed, right-click on [My Computer], and then select [System

Properties].If you can find a “Service Pack 2” string as shown below, Service Pack 2 is already

installed in your system.

NOTE: 1)If you have already installed our USB2.0 driver in Chapter 3-3, you don’t need to

                 install Microsoft USB2.0 driver.

             2)The screens below may be different when you install the Microsoft USB2.0 driver.
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3.Select the [Microsoft Windows Update] option and click [Next].

4.Click [Next].

5.Click [Finish] and restart your PC.

2.Select the [Search for a suitable driver for my device(recommended)] option and click

   [Next].
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6.To confirm the installation, follow the steps through:

    Right-click on [My Computer], select [Properties], and the [Hardware] tab.

    Click the [Device Manager] button. Please confirm the following three strings:

1)Confirm there is a [Texas

     Instruments OHCI Compliant

     IEEE 1394 Host Controller] string

    under the [IEEE 1394 Bus host

    controllers].

2)Confirm there is a [PCI standard PCI

    to PCI bridge] string under the

   [System devices].

3)Confirm there are two [NEC PCI to

    USB Open Host Controller] strings

    and a [NEC PCI to USB

    Enhanced Host Controller] and

    a [USB2.0 Root Hub] under

    the [Universal Serial Bus

    controllers].
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1.When you start your PC after installing the PCIFU2U, the following wizard will appear.

    select the [Install the software automatically(Recommended)]. Then,click [Next].

2.Click [Finish] and restart your PC.

NOTE: 1)Please note that you have to access to the Internet to install Microsoft USB2.0 driver.

               2)The screens below may be different when you install the Microsoft USB2.0 driver.

3-5.Windows XP Microsoft USB2.0 Driver Installation



W
in

do
w

s X
P

36

3.To confirm the installation, follow the steps through:

    Right-click on [My Computer], select [Properties], and the [Hardware] tab.

    Click the [Device Manager] button. Please confirm the following three strings:

1)Confirm there is a [Texas

     Instruments OHCI Compliant

     IEEE 1394 Host Controller] string

    under the [IEEE 1394 Bus host

    controllers].

2)Confirm there is a [PCI standard PCI

    to PCI bridge] string under the

   [System devices].

3)Confirm there are two [NEC PCI to

    USB Open Host Controller] strings

    and a [NEC PCI to USB

    Enhanced Host Controller] and

    a [USB2.0 Root Hub] under

    the [Universal Serial Bus

    controllers].
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3-6.Driver confirmation(Macintosh)

NOTE: 1)Only Low/Full Speed (1.5/12Mbps) is supported on Macintosh.

               2)The screens below may be different when you access to Apple web site.

If you have a Mac OS 9.x, please confirm the following two points:

1.Select [Extensions Manager] of the [Control Panels] in the Apple menu.

    Confirm the [FireWire Enable] and [FireWire Driver] components are installed.

2.Start [Apple System Profiler] in the Apple menu. Then, click the [Devices and Volumes] tab.

    Confirm a USB string is shown on the window.

If you can’t find any USB strings on the window, you need to download Apple support USB drivers

from Apple web site(www.apple.com).

To download and install it, follow the instructions described in the next page.

3-6-1.For Mac OS 9.x users
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2-1)Access to Apple web site(www.apple.com). Click the [Support] tab and click [Downloads].

        Then, type [USB Card Support] at the [Search for Downloads].

2-2)Double click the [USB Adapter Card 1.4.1 Document and Software].
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2-3)The following icon will mount after downloading.

2-4)License agreement window will appear. Click [Agree].

2-5)The following icon will mount. Double click [USB Adapter Card Support].

2-6)The following window will open. Double click the [Installer] icon.

If you have a Mac OS X, please confirm the following point:

    Start [Apple System Profiler] at the [Utilities] folder at the [Applications] folder.

    Click the [Devices and Volumes] tab to confirm the [USB] and [FireWire] strings are shown.

3-6-2.For Mac OS X users
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     With this Disk Partitioning and Formatting Software:FrFmtW9X, you can partition and format a Hard

     Disk Drive, MO, Zip, Jaz, etc. To partition and format a disk, follow the steps through.

NOTE: You can’t partition or format a CD-R, CD-RW, DVD-RAM, etc. with this FrFmtW9X.

                 This FrFmtW9X software runs only on Windows 98SE/Me.

       1.Confirm a device connected to the PCIFU2U is powered on.

       2.Insert the bundled RATOC IEEE1394 CD-ROM into the CD-ROM drive.

       3.Open [My Computer] and double click the CD-ROM drive icon.

           Then, double click the FfFmtW9X.EXE file.

4. Bundled Software
           This package includes the following software and utilities:

           1)Our original capture software: RsDvCap, RsDvStill, CompressAVI

            Refer to Chapter 5.

           2)Our original Disk Partitioning and Formatting software: FrFmtW9X

            Refer to Chapter 4-1.

           3)Our original Plug-In software for Adobe Premiere 5.1c.

            Refer to Chapter 4-2.

4-1.Disk Partitioning and Formatting Software

     If you have Windows 98SE/Me, refer to Chapter 4-1-1.

     If you have Windows 2000/XP, refer to Chapter 4-1-2.

4-1-1.For Windows 98SE/Me users
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       4.[Select the Drive] window will appear. Select a drive you want to partition and format and click

        [Select].

          NOTE:The [Select the Drive] window shows all the devices connected to SCSI, IDE

                        interface besides 1394 or USB interface. Be carefull not to select a wrong device.

                        If you select a wrong device and format it, all data in it will be lost.

5.[Format Utility] window will appear. Select [Initialize/Format media] from the [Edit] menu.
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6.[Initialize/Format Media] window will appear. Select a format type. Then, click [OK].

     NOTE:

If you do low level format and get an error

message saying you failed to initialize, the

device itself can’t treat low level format. In this

case, don't put a check mark at [Low level

format].

7.If you have selected IBM-PC/AT FDISK Format at step 6,  the message box saying [You

   should create partition next] will appear. Click [OK]. Then, you will see the screen shown in

   step 5. Select [Create Partition] from the [Edit] menu. After that, the [Create Partition] window

   shown below will appear. Select a File System from the list box and set a Partition size, using the

   slider bar. Then, click [OK] to create partition. If you have selected Super FD Format at step 6,

   a window similiar to the window below will appear. Select a File System and click [OK].
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4-1-2.For Windows 2000/XP users

           When you want to format a device such as a Hard Disk Drive, MO, Zip, Jaz on Windows 2000

           /XP, you can use [Computer Management] in Windows 2000/XP.

           Here is a brief explanation:

           1.Open [My Computer] and double click [Control Panel].

           2.Double click [Administrative Tools] and start [Computer Management].

           3.The following window will appear. Select [Disk Managemet] of the [Storage].

              For more information, refer to the Windows  2000/XP help or documents.
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4-2.Plug-In software for Adobe Premiere 5.1c

If you use this Plug-In software, you can use the following functions:

    1)Capturing a video from a DVCAM

    2)Converting a captured data to DV format

    3)Exporting a video to a DVCAM

To use this Plug-In software, the followings are required:

      OS : Windows XP/Me/2000/98 SE

      Premiere 5.1c (You don’t need this Plug-In software if you use Premiere 6.0 or later.)
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1.Insert the bundled RATOC IEEE1394 CD-ROM

   into your CD-ROM drive.

   Double click on the E:\PlugIn\Setup.exe file.

   (E means your CD-ROM drive. If your CD-ROM

    drive is not “E”, you must replace “E” to the

    appropriate drive letter.)

3.After confirming the destination of this Premiere

   5.1c Plug-In, click [Next]. Usually you don’t need

   to change this destination.

2.You will see the following window.

   Click [Next].

4.Select [Yes, I want to restart my computer now.]

   and click [Finish].

4-2-1.Installing the Plug-In software
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1.When you start Premiere, New Project

   Settings dialog will appear. Click

   [Load].

Before you start, you have to connect a DVCAM to a 1394 port before you start Premiere and

confirm a DV tape is inserted in the DVCAM and the DVCAM is set to VTR mode.

2.Load Project Settings dialog will

   appear. Select [DV Cam] and click

   [OK].

3.New Project Settings dialog will

   appear again. Click [OK].

4-2-2.Setting up Premiere project
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4.Select [Preferences] -> [Scrach Disk/

   Device Control...] from the [File] menu.

5.Select [Rs-Device-Control] from the

   [Device] list box. Then, click [OK].
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1.Select [Capture] -> [Movie Capture] from

   the [File] menu to show the capture

   window.

*Playback command will be sent to a DVCAM when you click [Record] even if a DV tape is

  stopped.

2.You can play back, pause, fast forward, rewind, using the Device Control button if your DVCAM

    is set to VTR mode. Move the point where you want to start capuring data. Then, play back the

    DV tape. Click [Record] to start saving an AVI file. To stop it, press the [ESC] key.

4-2-3.Capturing a video from a DVCAM

Device Control

button
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You can convert a captured data to DV format which allows you to export a video to a DVCAM.

1.While you create a project, select a format (e.g. CinePack) and do the video editting such as

    adding effect, etc.

    After you have finished video editting, select [Export]->[Movie] from the [File] menu.

2.Export Movie dialog will appear.

   Click the [Settings] button.

4-2-4.Converting a captured data to a DV format
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4.Select [32000Hz] from the

   [Rate] list box in the [Audio

   Settings] and click [OK].

5.Type a movie file name you

   want to create in the [File

   name] box and click [Save].

   File conversion will start.

3.Export Movie Settings

    dialog will appear. Select

   [DV  Cam Export] from

  the [File Type] list box.
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1.Select [Capture]->[Movie

   Capture]  from the [File] menu

   or hit the [F5] key to show the

   capture window.

   Focus on the [Timeline window]

   and select [Export]->[Export to

   Tape] from the [File] menu.

2.Building preview file will start.

3.Select a file you want to export.

   Click [Open] to start exporting

   the video to a DVCAM.

If you don’t show the capture

window, you can’t export a

video.If you don’t focus on

[Timeline window], the

[Export to tape] item of the

menu is disabled.

NOTE:

1)You can export only an AVI file which captured from a DVCAM directly, or data which

    was converted to DV format as explained in 4-2-4. Converting a captured data to DV

    format.

2)While you export a video, the video isn’t previewed on the movie capture window of

   your PC.

4-2-5.Exporting a video to a DVCAM
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Q.I can’t show a video in the capture window.

A.If you are using Windows 98SE/Me, right click on [My Computer] and select [Properties]. Click the

    [Device Manger] tab and confirm your camera and sound device are working properly.

    If you are using Windows 2000, right-click [My Computer] and select [Properties].

    Click the [Hardware] tab and the [Device Manger] button. In the Device Manger windows, confirm

    your camera and sound device are working properly.

Q.I can’t export a video to a DVCAM.

A.To export a video, you need to open the capture window.

4-2-6.Plug-In Software troubleshooting
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Installing RsDvCap/RsDvStill/CompressAVI

1.Close all programs currently running on your computer.

2.Set the bundled RATOC IEEE1394 CD-ROM in your CD-ROM drive.

3.Open [My Computer] and double-click CD-ROM drive icon.

4.Open   [Win98SE], [WinMe],[Win2000] or [WinXP] folder.

   If your Windows version is Windows 98 SE, open  [Win98SE] folder.

   If your Windows version is Windows ME, open  [WinMe] folder.

   If your Windows version is Windows 2000, open  [Win2000] folder.

   If your Windows version is Windows XP, open  [WinXP] folder.

5.Double-click the [RsDvCap] folder.

6.Double-click on [Setup.exe] to install the capture software.

7.Select a language. You will see the screen below.Click [Next].

5. Setting up capture software
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10.You will see the screen below.

      Select [Yes, I want to restart my computer now] and click [Finish].

      You have now completed installing the capture software.

  NOTE:

  If you have installed this software already and start this installer, this installer will delete

  the software and end. You have to start the installer again to install this software.

8.You will see the screen below. Click [Next].

9.You will see the screen below. Click [Next].
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6. How to use RsDvCap
 What is the RsDvCap?

This application software has the following functions.

•Preview and capture video/sound data from a DVCAM.

•Preview and capture video data from a CCD camera.

•Export media file from a PC to a DVCAM.

•Playback media file.

    Main menu    Camera Control Bar              Camera and Audio Select Bar

                                                                                                             Batch Capture List Bar

     NOTE:

1)This software uses Microsoft standard DV-AVI2 format video file.

      2)To capture correct DV file, you have to use original DV footages which has

           continuous Timecode(recording). If the original DV footage has intermittent

         Timecode, sometimes it may cause system freeze or may not be captured.

Video Control Bar
RsDvCap Main Screen
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6-1.Main menu:

Top menu      Sub menu                   Description

 File              Review movie file

                      END                                           Terminate this application.

 Setting         DV Batch Capture                   Show batch capture dialog box.Refer to 6-6.DV

                                                                       Batch Capture.

                       Application Setting                  Show RsDvCap parameter setting dialog box.

                                                                       Refer to 6-3.Application settings.

                      Cam Setting                             Show CCD camera control dialog box.

 View            Camera Audio Select Bar

                      Camera Control Bar

                      Video Control Bar

                      Batch Capture List

 Display

  Select an AVI file you want to play back.

Show Camera and Audio Select Bar.

Refer to 6-2-1.Camera and Audio Select Bar.

Show the DVCAM camera mode control bar.

You can control a DVCAM.Refer to 6-2-2.

Camera Control Bar.

Show the DVCAM video mode control bar.

You can control a DVCAM.Refer to 6-2-3.

Video Control Bar.

Show the Batch Capture List Bar.You can

capture favorite scenes in a DV tape to your

HDD.Refer to 6-6.DV Batch Capture.

Select the size of the preview window.

The preview window of the [PC] is 4:3.

The preview window of the [DV] is 3:2.
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6-2.Control Bars

6-2-1.Camera and Audio Select Bar:

This bar has the Camera list box and Sound device list box as shown above. Camera list

box displays a list of camera device connected to your PC. If this list box is blank, your camera

isn’t recognized. If your camera is recognized, “Microsoft DV Camera and VCR” string will

appear. Sound device list box displays a list of sound device.

6-2-2.Camera Control Bar :

You can preview and capture a video image from the connected DVCAM. The bar will

appear automatically when the DVCAM is set to camera mode. The DVCAM have a switch

which selects video mode or camera mode. Set this switch to camera mode to preview and cap-

ture a video image.

              .....When you click this button, you can preview a video image.

              .....When you click this button, you can pause a video image.

              .....When you click this button, you can capture a video image to the HDD.

               .....When you click this button, you can stop previewing or capturing a video image.

               .....When you click this button, you will see the Help contents.

                .....When you click this button, you can play back an AVI file.

          Camera list box             Sound device list box
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6-2-3.Video  Control Bar :

You can control a DVCAM from this control bar. The DVCAM have a switch which selects video

mode or camera mode. If you set this switch to camera mode or a DV tape is not inserted, this

control bar will be disabled automatically. Set this switch to video mode to control the DVCAM.

The functions are below:

             ...Rewind

             ...Previous frame

             ...Play

             ...Next frame

             ...Pause

             ...Stop

             ...Fast forward

             ...Record

              ...Pause recording

                                          When you click the Capture Now button, you can start to capture

                                          DV data from a DVCAM. The [Capture Now] will change to

                                        [Capture Stop].

                                         When you click the DV Export button, you can export DV data to

                                         a DVCAM.You can see the DV data on the screen of the DVCAM.

                                           1.If you don’t want to record DV data onto your DV tape,

                                               don’t check “Record on the tape”.

                                           2.If you really want to record DV data onto your DV tape,

                                              check “Record on the tape”.

 ,
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6-3.Application settings

When you select [Application setting] of the [Setting] menu, you will see the dialog box below.

You can set up this application’s behavior.
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Category             Item                              Description

Camera Mode          CCD Mode                        Select when you use a CCD camera.

                                   DV Mode                          Select when you use a DVCAM.

 Preview Settings       Display TimeCode            If checked, timecode will be displayed.

                                   DV Codec Resolution

 Capture Settings    Capture With Preview

                                  Rename file name

                                  every capture execution

You can select DV Codec Resolution. If you

select a higher resolution, you will get a better

image. This DV Codec Resolution affects

only the preview quality.

 If checked, video images will be displayed

 in the preview window during capturing

 video stream. When you check here,

 it will be a heavy load on your PC.

 If you have problems of dropping frames

 or sounds, don’t check this option.

If checked, every time you start and stop

capturing a  video, the file rename dialogbox

will appear. You can set a file name and loca-

tion to save the file in. If you don’t check here,

a captured file will be saved automatically

under the name of CAPTIME+(Time)

+Year+(Date).AVI in the folder you set at

“Set Folder Name To Save Capture  Files”.
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Category             Item                                Description

DVCAM Settings    Check DVCAM Mode If you click here, this application will detect

whether your DVCAM is in camera mode

or video mode automatically. If your

DVCAM is in video mode, the Camera Con-

trol Bar will disappear. If your DVCAM is in

camera mode, the Camera Control Bar will

appear and the Video Control Bar will be

disabled.

                                   Enable Step Control

                                 By Mouse Wheel

If you check here, you can control a

camera with your mouse as shown below.

1)When you click wheel,

    a DVCAM starts to play.

2)When you turn wheel down,

    a DVCAM starts to rewind.

3)When you turn wheel up,

    a DVCAM starts to fast forward.

4)When you click the right button,

    a DVCAM stops.
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CCategory           Item                                Description

When you control a DVCAM from the PC

consecutively, it takes some time for the

DVCAM to get ready for a next command

from the PC. This time depends on the

DVCAM. If you have trouble in controlling

the DVCAM from the PC consecutively,

change this value to a longer time than 4 sec-

onds. Default time is 4 seconds. For example,

5 seconds.

DVCAM Command

Response time

 DV Export prefix time When you export an AVI file to a DVCAM,

there is data prefix time from starting to ex-

port the AVI file to recording it onto a DV

tape. The data prefix time results in failing to

record the beginning of the AVI file onto the

DV tape. To avoid this problem, you can set

a time here. During the time you set here, blank

data will be exported to the DVCAM and it

avoids failing to record the beginning of the

AVI file onto the DV tape.
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6-4.Capturing a video from a DVCAM in camera mode
When you want to capture a video image from a DVCAM set to camera mode, follow steps

through.

1. Confirm a DVCAM is set to camera mode.

   Camera mode means you can capture a video image. If your DVCAM is in video mode,

   change mode selection switch from video mode to camera mode slowly. Everytime you change

   DVCAM’s Mode Control switch, move this switch to OFF position and confirm that the

   RsDvCap’s Camera device name will disappear. After that, you can change this switch to your

   choice and the camera device name will appear.

2. Select [DV mode] on the [Application Setting] as shown in 6-3.Application settings.

3. Click the                 button on the Camera Control  bar. A video image from a DVCAM

    will appear.

4. Click the                                           button to start capturing.

5.Click the                                         button to stop capturing.

   You can also stop capturing by using the                 button on the Camera Control Bar or

    pressing ESC button on the keyboard.

6. If you checked [Rename file name every capture execution] on the [Application Setting],

    You will see the window.You can

    rename the captured file.

7.The file will be saved in the folder

   you set at [Set Folder Name To Save

   Capture Files] on the [Application

   Setting].

   NOTE:

    When you preview, it puts some load on PCs. If data loss happens, don't check [Capture

    With Preview] on the [Application Setting]. For more information, please refer to Chapter

    9-2.When you play back the captured file, it gets choppy.
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6-5.Capturing a video from a DV tape

1. Set a DV tape in a DVCAM and confirm the DVCAM mode is set to video mode.

    Video Mode means you can control a video of a DV tape. If your DVCAM is in camera

    mode, change mode selection switch from camera mode to video mode slowly as

    mentioned 6-4.Capturing a video from a DVCAM in camera mode.

2.Select [DV mode] on the [Application Setting] as shown in 6-3.Application settings.

3.When you click the               DV play button on the Video Control Bar, the DV tape will start

    to play and a video image of the DV tape will appear in the preview window.

4.Click the                                        button to start capturing.

5.Click the                                        button to stop capturing.

   You can also stop capturing by using the                 stop button on the Video Control Bar or

    pressing ESC button on the keyboard.

6. If you checked [Rename file name every capture execution] on the [Application Setting],

    You will see the window.You can

    rename the captured file.

 7.The file will be saved in the folder

    you set at [Set Folder Name To

    Save Capture Files] on the

    [Application Setting].

When you want to capture a video image from a DV tape, follow steps through.

NOTE:

1)When you preview, it puts some load on PCs. If data loss happens, don't check

   [Capture With Preview] on the [Application Setting]. For more information, please refer

   to Chapter 9-2.When you play back the captured file, it gets choppy.

2)To capture correct DV file, you have to use original DV footages which has

    continuous Timecode(recording). If the original DV footage has intermittent Time

   code, sometimes it may cause system freeze or may not be captured.
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6-6.DV Batch Capture

Batch capture function saves video images files as your time

scheduling. To batch capture video images from a DV tape,

follow steps through.

1.To show the Batch Capture Window as shown right, select

   [Batch Capture List] of the [View] in the system menu.

2.Set a DV tape in a DVCAM and confirm the DVCAM

   mode is set to video mode. Video Mode means you can

   control a video of a DV tape. If your DVCAM is in camera

   mode,change mode selection switch from camera mode to

   video mode slowly as mentioned 6-4.Capturing a video

   from a DVCAM in camera mode.

3. Click the               DV play button on the Video

    Control Bar to play the DV tape.

4. Click the               In point button when you want to start

    capturing.

5. Click the               Out point button when you want to stop

    capturing.

6. Click the                     Add button to add time code to the

     window as shown above.

   To capture other Video images of the DV tape, repeat the

   steps from 4 to 6.

7.Click the                          start button to show the Batch

    Capture dialog box as shown in the next page.
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9. The Batch Capture dialog box will be shown. Click [RUN] to start batch capture.This

     application searchs automatically the timecode you have just set and starts to capture video

     images and saves the file in the folder written in the “Export Directory” under the name of

     Video + (number) starting 1 + .avi as shown below. When batch capture is finished,

     “Capture Complete!” message will appear.Click [END] to finish batch capture.

   NOTE:

   To capture correct DV file, you have to use original DV footages which hascontinuous

   Timecode(recording). If the original DV footage has intermittent Timecode,

   sometimes it may cause system freeze or may not be captured.

8.You will see the screen. Click [OK] to continue.
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6-7.Exporting a video data to a DVCAM
When you want to export an video data to a DVCAM, follow steps through.

1. Set a DVCAM to video mode.

    Video Mode means you can control a video of a DV tape.

     If your DVCAM is in camera mode, change mode selection switch from camera mode to video

    mode slowly as mentioned 6-4.Capturing a video from a DVCAM in camera mode.

2. Click the                                                     DV Export button. The File select dialog box will appear.

    Select an AVI file you want to export, and click [SAVE] button. The AVI data will be exported

    to the DVCAM.

    When you check “Record on the tape”, “Video image” and “Rec command” will be sent

    to the DVCAM. This means the AVI file will be really overwritten to your DV tape. So, you

    should be careful not to overwrite important DV tapes.

    When you don’t check “Record on the tape”, only “Video image” will be sent to the DVCAM.

    This means the AVI file will not be overwritten to your DV tape. You can just see the video

    image on the screen of the DVCAM.

3.Click  the                 stop button in the Camera Control Bar to stop exporting.

NOTE

There is time-delay between start of video stream and the DVCAM actually starting

to record. So, for a few seconds at the head of video stream, nothing will be recorded on

your DV tape.

NOTE:

Only a Microsoft DV AVI 2.0 with DVSD(Digital Simultaneous Voice and Data) can be

exported to a DVCAM.
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7. How to use RsDvStill

      What is the RsDvStill?
This application software has the following functions.

           •Preview video data from a DVCAM/a CCD camera.

           •Save a still image to a BMP file.

When RsDvStill starts with a DVCAM connected to the PCIFU2U, RsDvStill will detect whether

the DVCAM is in camera mode or in video mode automatically and pauses the DV tape if the

DVCAM is set to video mode and there is a DV tape in the DVCAM.

7-1.Main menu

Camera Control Button.

SSlider

 Preview Window  Thumbnail Window

    NOTE:

    To capture correct DV file, you have to use original DV footages which has continuous

    Timecode(recording). If the original DV footage has intermittent Timecode, sometimes

    it may cause system freeze or may not be captured.
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Category                        Description

DV Maker                                 This list box shows a list of DVCAM manufacturer such as

                                                Sony, JVC, Panasonic, Canon, Sharp, etc. Choose your

                                                  DVCAM manufacturer. If you can’t find it, choose OTHER.

Image Size                                There are 3 kinds of resolution:720 x 480, 360 x 240, 88 x 60.

                                                 This value means raw data from a DVCAM.

Slider Bar                                 You can select a favorite scene from video capture data by

                                                     moving this slider bar. This slider bar is enabled when you click

                                               the Capture button.

                                                 You can capture video images for about 1 second by clicking

                                                   this button. After clicking this button, preview will be stopped.

                                                  You can save a BMP file on the preview window.

                                                  The BMP file will be saved and be held at the top of  the

                                                  thumbnail window.

Video Device                           Video Device displays a list of camera device connected to

                                                  your PC. If this list box is blank, your camera isn't recognized.

                                                 If your camera is recognized, “Microsoft DV Camera and

                                                VCR” string will appear.

Camera Control Button            When a DVCAM is in video mode, you can control a DV tape

                                                as follows.

                 ,                ............Play, Stop

                                 .............Pause

                     ,             .............Fast Rewind, Fast Forward or Slow Rewind, Slow Forward

                     ,            ..............Previous Frame, Next Frame
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Category                        Description

Time Code                                This box shows the timecode information of your DV tape.

                                                 This timecode format is HOUR:MINUTE:SECOND:FRAME.

                                                  When you click this button, you will see the screen below. You

                                                 can select a folder where you want to save a BMP file.

                                                 This button will be enabled only when you click the

                                                                              button. When you click the

                                                 button, preview will be paused. When you want to resume

                                                previewing, click the                 button.

                                                 This button will be enabled only when you use a CCD camera.

                                                 When you click this button, you can display the CCD camera

                                                  control dialog box. With this dialog, you can control a CCD

                                                camera. For example, zoom, focus, etc.
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7-2.How to save a BMP file

       (1)Save a BMP file from a DV tape

         1.Set a DV tape in a DVCAM and confirm the DVCAM mode is set to video mode.

             Video Mode means you can control a video of a DV tape. If the DVCAM is in camera mode,

              change mode selection switch from camera mode to video mode slowly as mentioned 6-4.

            Capturing a video from a DVCAM in camera mode.

        2.Starting RsDvStill, your DV tape will be paused and  the            button is disabled.

          Set DV Maker and decide Image Size.

        3.Click  the   button. You will see the dialog box. Select a folder where you want to

            save a BMP file and click OK. If you don’t select a folder, a BMP file will be saved in the

            folder where this application is installed.

        4. Find a favorite scene on the DV tape, using the camera control button.

            (TIPS)

            When the            button is disabled, click the           button and the            button.

             You can preview slowly. When the            button is enabled, click the            button.

             After that,click the          button and the            button. You can preview slowly.

       5.There are two ways to save a BMP file as  follows.

           5-1.Click the               button. The BMP file will be saved in the folder under the name

                   of  “Image+ (number) + .BMP” and the BMP file will  be held at the top of the

                     thumbnail window. If you double click the thumbnail, you can view it with real BMP

                  file size.

           5-2.Click the                           button.After capturing, the DV tape will be paused. Then move

                   the slider to a favorite scene and  click the                                   button. The BMP file will

                   be held as mentioned above. If you want to resume previewing, click the                 button.
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       (2)Save a BMP file from a DVCAM in camera mode or a CCD camera

         1.Set a DVCAM to camera mode. Camera mode means you can capture a video image. If your

             DVCAM is in video mode, change mode selection switch from video mode to camera mode

             slowly as mentioned 6-4.Capturing a video from a DVCAM in camera mode.

           When you use a CCD camera, skip this step.

        2.Starting RsDvStill, set DV Maker and decide Image Size. When you use a CCD camera,

           DV Maker list box is disabled. So, decide Image Size.

        3.Click  the   button. You will see the dialog box. Select a folder where you want to

            save a BMP file. Then click OK. If you don’t select a folder, a BMP file will be saved in the

            folder where this application is installed.

        4.There are two ways to save a BMP file as follows.

            4-1.Click the                 button. The BMP file will be saved in the folder under the name

                     of Image+ (number) + .BMP  and the BMP file will  be held at the top of the thumbnail

                     window. If you double click the thumbnail, you can view it with real BMP file.

            4-2.Click the                            button.After capturing,preview will be paused. Then move the

                    slider to a favorite scene and click the                               button. The BMP file will  be held

          as mentioned above. If you want to resume previewing, click the                 button.

   NOTE:

    When you use a CCD camera, the                   button is enabled. Using this button,

    you can control the CCD camera. For example, zoom, focus, etc.
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8. How to use CompressAVI

  What is CompressAVI application software?

         This application software has the following functions.

         Convert Microsoft DV-AVI2 format video file to another format video file bi-directionally.

         As current existent video editing software don't support DV-AVI2 format video file,

         you have to convert the format of video file which is captured by RsDvCap before editing.

         And after editing, if you want  to export it to a DVCAM, you have to re-convert video file to

         DV-AVI2 format video file.

         Please note, file conversion will take a long time, sometimes over a hour.
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  3.Please specify an original video file and a converted video file name.

     Click [Next]. (After conversion, an original video file remains in the Hard Disk Drive.)

8-1.How to convert the DV-AVI2 format to other formats

After you convert the AVI files made by RsDvCap, you can edit it with video editting software.

1.When you start the CompressAVI, you will see the screen below. Click [Execute].

  2.Please select “Convert DV-AVI fomat to other video format” and select Resolution.

     Click  [Next].
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4.Please choose a conversion filter from the Compression formats list box.

    AVI files made by RsDvCap have a DV-AVI2 format.

    So, select the other compression formats than DV Video Encorder.

 There are many kinds of compression formats.

 (Compression formats appeared in the [Compression formats] list box depend on your system)

Popular compression formats are explained below.

1.Microsoft Video1

   It does not take much time to convert because this type will lose quality and cause poor image.

2.Microsoft MPEG4

   If you use this type of codec, file size will be compressed to about one-tenth and keep good

   quality.

3.Intel Indeo(R) video3.2

   This type of codec was invented by Intel.

   Compression rate and quality get better than Microsoft Video1

4.Intel Indeo(R) video5

   Compression rate will get better under MMX(R) or Pentium(R) II processor.

5.CinePak Codec

   It takes much time to convert but this type will keep quality.

6.DV Video Encorder

   This type of codec can capture a video from a DVCAM in real time.

   RsDvCap uses this type of compression and creates AVI files.

7.Non compression

    This type saves data without compression.
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5.Click [Next]. The file conversion starts. It takes much time to convert an AVI file.

      Conversion time depends on the type of compression format. Please wait patiently.

6.When conversion ends, you will see the screen below. Click [Finish].

   You can now do a video editing with your video editting software.
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8-2.How to convert other formats to the DV-AVI2 format

You can export a video to a DVCAM after you convert an existing AVI file to the DV-AVI2

format.

1.When you start the CompressAVI, you will see the screen below. Click [Execute].

2.  Please select “Convert other video file format to DV-AVI file format” and

     and choose NTSC or PAL. NTSC is used in the U.S.A. PAL is used in Europe and Asia(except

     Japan). Then click [Next].
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5.When conversion ends, you will see the screen below. Click [Finish].

    You can now export the converted data to a DVCAM by using RsDvCap.

3.Please specify an orginal video file and a converted video file name. Click [Next].

4.Click [Next]. It may take much time to convert an AVI file. Please wait patiently.
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9. Troubleshooting

  9-1.A camera can’t be recognized

        If your camera is recognized by our capture software(RsDvCap,RsDvStill), Camera list box in

        RsDvCap or Video Device in RsDvStill shows the Microsoft DV Camera and VCR string.

        If the box is blank, camera is not recognized.

        General Solution:

       1.The PCIFU2U PCI Board isn’t firmly seated in the PCI slot.

           If your PCI Board is inserted correctly, you will see the screen below in the Device Manager

            and you can find a [Texas Instruments OHCI Compliant IEEE 1394 Host Controller] string.

Check here

(OS:Windows 98SE)

     2.If you use Windows 98SE/2000, there have to be a [Microsoft DV Camera and  VCR] string

         under the “Imaging Device” in the Device Manager. If you can’t find it, confirm your DVCAM

       is powered on.

        If you use Windows Me/XP, there have to be a camera name string under the  “Imaging Device”

        in the Device Manager. If you can not find it, make sure your DVCAM is powered on.
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     9-2.When you play back the captured file, it gets choppy

IThe data rate from a DVCAM is 3.6MB/sec. If your HDD sustainted data write rate is lower

  than 3.6MB/sec., a captured file may get choppy or jerky when you play back the file.

  To avoid this trouble, enable DMA function of your HDD, following the steps through.

 1.Open “Device Manager”.

  2.Select your Disk drive as shown below and click the Properties buton.

(OS:Windows 98SE)

3.Click the [Setting] tab and if DMA box is not checked,check here.

    But, please note that if your HDD is not Ultra DMA HDD, don’t check here.

    To confirm that your HDD is Ultra DMA HDD, refer to your HDD manual.
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10. Registration and Tech-Support

10-1. How to Register

We highly recommend to register yourself as our customer through our on-line registration.

1. On the Internet, access our site (http://www.ratocsystems.com/english/)

2. Follow window menu guide to register.

3. Fill out and submit the registration form.

10-2. Software Update and Support
-Software Update-

The latest driver and application software are subject to change for improvement or bug fix.

You can download the latest version from our web site.

(http://www.ratocsystems.com/english/)

-Technical Support-

You can get a Tech support from RATOC at the following.

(Open Monday - Friday, 9:30A.M. to 5:00P.M.(PST))

 RATOC Systems International,Inc. Tech support

   Address:  1933 O’Toole Avenue Suite A109

                   SanJose, CA 95131, U.S.A.

   Phone   :  (408)955-9400

   Fax       :  (408)955-9402

   E-mail    :  int-support@rexpccard.co.jp

   Web        :   http://www.ratocsystems.com/english/

NOTE

Please include the following information:

•Our product name, serial number, and product description

•Host Computer Name, Windows version

•Application software/driver version
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11. Specifications

      Product Name              :PCIFU2U USB2.0/IEEE1394 Combo PCI Board

      Operating Environment                    :

                    Power Consumption:5V, 12V

                    Temperature            : 0°C(32°F)-55°C(131°F)

                    Relative humidity    : 95% Max. (Non-condensing)

      Dimensions                                       :130(L) x 100(W) mm

(PCI Full Height Half Size)
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Appendix

Trademarks

-Windows is a trademark of Microsoft Corporation, registered in the U.S. and other countries.

-USB 2.0 Hi-Speed logo is a registered trademark of Universal Serial Bus Implementers Forum.

-‘Mac’, ‘PowerMacintosh’, ‘Mac logo’, ‘FireWire’, and FireWire logo are registered trademarks of Apple Computer, Inc.

  registered in U.S. and other countries.

-‘iLINK’ and ‘iLINK’ Logo are registered trademarks of Sony corporation.

-Other brand and product names may be registered trademarks or trademarks of their respective holders.

FCC Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of

the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential

installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in

accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee

that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or

television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to

correct the interference by one or more of the following measures:

(1) Reorient or relocate the receiving antenna.

(2) Increase the separation between the equipment and receiver.

(3) Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

(4) Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the party responsible for compliance may result in this unit not

complying with FCC Rules Part 15.
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